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Discussão

Como Implementar??? (1)

I Como implementar uma ferramenta que avalie a cobertura de
comandos em um programa?

�
2 p u b l i c v o i d b o l h a ( i n t [ ] a , i n t s i z e ) {
3 i n t i , j , aux ;
4 f o r ( i = 0 ; i < s i z e ; i ++) {
5 f o r ( j = s i z e − 1 ; j > i ; j−−) {
6 i f ( a [ j − 1 ] > a [ j ] ) {
7 aux = a [ j − 1 ] ;
8 a [ j − 1 ] = a [ j ] ;
9 a [ j ] = aux ;

10 }
11 }
12 }
13 }� �
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Discussão

Como Implementar??? (2)

I Quais os passos essa ferramenta deveria executar?

I Você é capaz de visualizar alguma otimização nesse processo?
O que pode ser melhorado?
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Pre-requisitos

Pre-requisitos

I Conhecimento da Linguagem Java.

I Conhecimento de Critérios de Teste Estruturais (Fluxo de
Controle).

I Kit de Desenvolvimento Java – Versão 1.5 ou superior.

I Ambiente de desenvolvimento Eclipse 3.5 ou superior.

I Ferramenta EclEmma – Versão 2.2.1 ou superior.
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Instalação

Instalação da EclEmma (1)

I Página do projeto:

http://www.eclemma.org/

I Pode ser instalada pelo menu Help->Install New
Software... na versão tradicional do Eclipse ou pelo Eclipse
Market Place na versão J2EE. Opcionalmente é posśıvel
instalar via distribuição compactada.

I Atualmente na versão 2.2.1

I A seguir são apresentadas as telas da instalação pela versão
tradicional do Eclipse. Para mais detalhes visite
http://www.eclemma.org/installation.html.

Vincenzi, Delamaro & Maldonado

Plugin EclEmma 2.2.1 8/52

http://www.eclemma.org/
http://www.eclemma.org/installation.html


Organização Ferramenta EclEmma Instrumentação Off-line Gerando o Relatório de Cobertura Outras Ferramentas Similares Exerćıcio

Instalação

Instalação da EclEmma (2)

I Entre no menu Help->Install New Software... e preencha o
campo Work with: com http://update.eclemma.org/.

I Clique em Add e dê um nome ao repositório, por exemplo,
Eclemma.

I Selecione EclEmma e prossiga com a instalação normal.

I A sequência de telas é apresentada a seguir.
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Instalação

Instalação da EclEmma (3)
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Instalação

Instalação da EclEmma (4)
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Instalação

Instalação da EclEmma (5)
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Instalação

Instalação da EclEmma (6)
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Instalação

Instalação da EclEmma (7)
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Instalação

Instalação da EclEmma (3)

I EclEmma pode ser executada de várias formas distintas
I Execução direta com a instrumentação ocorrendo on-the-fly

via Eclipse.
I Execução via script Ant (http://ant.apache.org/).
I Execução via script Maven (http://maven.apache.org/)

I Este material ilustrada a utilização via execução direta e via
Maven.
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A Ferramenta

A Ferramenta EclEmma

I Ferramenta de código aberto para o teste de programas Java
baseada na biblioteca JaCoCo
(http://www.eclemma.org/jacoco/).

I Passos básicos para uso da ferramenta:
I Instrumentar as classes a serem testadas.
I Executar as classes instrumentadas com os casos de testes.

I Importa casos de testes do JUnit.
I Aceita também casos de testes em outros formatos. Basta

executar as classes instrumentadas. Cada execução
corresponde a um novo caso de teste.

I Gerar relatórios de cobertura.
I Com base nos relatórios decidir por continuar ou não com os

testes.

I O processo de instrumentação pode ocorrer on-the-fly ou
off-line.

Vincenzi, Delamaro & Maldonado

Plugin EclEmma 2.2.1 16/52

http://www.eclemma.org/jacoco/


Organização Ferramenta EclEmma Instrumentação Off-line Gerando o Relatório de Cobertura Outras Ferramentas Similares Exerćıcio

O Exemplo

Programa Exemplo (1)

I Programa Identifier

I Código: Identifier.java e IdentifierMain.java

I Classe principal: Identifier
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O Exemplo

Programa Exemplo (2)

I Para executar os testes do JUnit no Identifier e avaliar qual a
cobertura de código obtida, basta seguir os passos abaixo:

I Abra ou crie um projeto para o Identifier no Eclipse
(preferencialmente um Projeto Maven)

I Clique com o botão direito sobre a classe de teste
IdentifierTestCase.java, por exemplo.

I Entre no menu Coverage As->JUnit Test
I Nesse momento, as classes do código fonte são compiladas e,

antes de serem carregadas para execução, é feita a
instrumentação das mesmas diretamente no bytecode gerado.

I Com isso, os casos de teste do JUnit são executados nas
classes instrumentadas e a cobertura pode ser monitorada.

I O resultado da execução é apresentado a seguir.
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O Exemplo

Programa Exemplo (3)
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O Exemplo

Programa Exemplo (4)

I Observe que as classes de teste também foram inclúıdas na
análise.

I Com isso, o número de requisitos aumenta e o ńıvel de
cobertura diminui.

I Em geral não se deseja medir a cobertura do código de teste,
apenas da aplicação.

I Para isso, é posśıvel configurar quais classes devem ser
consideradas.

I Entre em Window->Preferences e escolha Java->Code
Coverage.

I Na tela que irá abri, preencha o campo Only path entries
matching: e preencha com src/main/java.
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O Exemplo

Programa Exemplo (5)
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O Exemplo

Programa Exemplo (6)

I Clique no duplo “X” na janela de relatório (Coverage) para
remover todas as sessões de execução.

I Execute novamente o conjunto de teste do JUnit utilizando a
opção Coverage As->JUnit Test.
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O Exemplo

Programa Exemplo (7)
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O Exemplo

Programa Exemplo (8)

I EclEmma apresenta relatórios de cobertura para os seguintes
critérios:

I Contagem de Instruções (bytecode)
I Contagem de Desvios
I Contagem de Linhas (código-fonte)
I Contagem de Métodos
I Contagem de Tipos
I Contagem de Complexidade

I Uma definição de cada um desses critérios pode ser
encontrada em http:

//www.eclemma.org/jacoco/trunk/doc/counters.html
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O Exemplo

Programa Exemplo (9)
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O Exemplo

Programa Exemplo (10)

I Para gerar o relatório de cobertura, basta clicar com o botão
direito na área do relatório da interface gráfica e escolher a
opção ExportSession....

I Em seguida, basta navegar até o local onde se deseja gerar o
relatório, escolher o formato do mesmo e clicar em Finish.

I A sequência de telas para isso é mostrada a seguir, bem como
um exemplo do relatório gerado.
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O Exemplo

Programa Exemplo (11)
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O Exemplo

Programa Exemplo (12)
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O Exemplo

Programa Exemplo (13)
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Objetivo

I O processo de instrumentação off-line, serve para que uma
versão instrumentada da aplicação para ser executada fora do
ambiente de desenvolvimento mas, mesmo assim, ser posśıvel
monitorar a cobertura de código.

I Sua principal utilidade é na condução de testes funcionais de
sistemas, permitindo uma posterior análise da qualidade do
teste funcional que foi executado.

I Além disso, é posśıvel entregar uma versão instrumentada da
aplicação para um usuário para descobrir qual o perfil de
execução desse usuário particular.

I Essas informações são importantes para priorizar a execução
de testes e também para avaliar a qualidade dos critérios de
teste funcionais empregados.
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (1)

I JaCoCo é a API empregada pela EclEmma para o
monitoramento de cobertura de código on-the-fly.

I A mesma API pode ser empregada para a geração de uma
versão instrumentada off-line da aplicação em teste.

I A documentação de como usar a JaCoCo em modo off-line
está dispońıvel em: http:

//www.eclemma.org/jacoco/trunk/doc/index.html

I Para isso, o primeiro passo, é criar um novo arquivo de
configuração do Maven (pom-jacoco.xml, por exemplo) com
o conteúdo apresentado a seguir e também dispońıvel em
http://www.eclemma.org/jacoco/trunk/doc/examples/

build/pom-offline.xml:
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (2) �
1 <p r o j e c t xmlns=”h t t p : //maven . apache . org /POM/ 4 . 0 . 0 ” x m l n s : x s i=”h t t p : //www. w3 . org /2001/XMLSchema−i n s t a n c e ”
2 x s i : s c h e m a L o c a t i o n=”h t t p : //maven . apache . org /POM/ 4 . 0 . 0 h t t p : //maven . apache . org / xsd /maven −4 . 0 . 0 . xsd ”>
3 <m o d e l V e r s i o n>4 . 0 . 0</ m o d e l V e r s i o n>
4 <g r o u p I d> I d e n t i f i e r</ g r o u p I d>
5 <a r t i f a c t I d> I d e n t i f i e r</ a r t i f a c t I d>
6 <v e r s i o n>1 . 0</ v e r s i o n>
7 <name> I d e n t i f i e r</name>
8 <d e s c r i p t i o n>V a l i d a d o r de i d e n t i f i c a d o r</ d e s c r i p t i o n>
9 <b u i l d>

10 <p l u g i n s>
11 <p l u g i n>
12 <g r o u p I d>org . apache . maven . p l u g i n s</ g r o u p I d>
13 <a r t i f a c t I d>maven−c o m p i l e r−p l u g i n</ a r t i f a c t I d>
14 <v e r s i o n>3 . 1</ v e r s i o n>
15 <c o n f i g u r a t i o n>
16 <s o u r c e>1 . 5</ s o u r c e>
17 <t a r g e t>1 . 5</ t a r g e t>
18 </ c o n f i g u r a t i o n>
19 </ p l u g i n>
20 <p l u g i n>
21 <g r o u p I d>org . j a c o c o</ g r o u p I d>
22 <a r t i f a c t I d>j a c o c o−maven−p l u g i n</ a r t i f a c t I d>
23 <v e r s i o n>0 . 6 . 4 . 2 0 1 3 1 2 1 0 1 1 0 7</ v e r s i o n>
24 <e x e c u t i o n s>
25 <e x e c u t i o n>
26 < i d>d e f a u l t−i n s t r u m e n t</ i d>
27 <g o a l s>
28 <g o a l> i n s t r u m e n t</ g o a l>
29 </ g o a l s>
30 </ e x e c u t i o n>� �
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (3)

�
31 <e x e c u t i o n>
32 < i d>d e f a u l t−r e s t o r e−i n s t r u m e n t e d−c l a s s e s</ i d>
33 <g o a l s>
34 <g o a l>r e s t o r e−i n s t r u m e n t e d−c l a s s e s</ g o a l>
35 </ g o a l s>
36 </ e x e c u t i o n>
37 <e x e c u t i o n>
38 < i d>d e f a u l t−r e p o r t</ i d>
39 <phase>p r e p a r e−package</ phase>
40 <g o a l s>
41 <g o a l>r e p o r t</ g o a l>
42 </ g o a l s>
43 </ e x e c u t i o n>
44 <e x e c u t i o n>
45 < i d>d e f a u l t−check</ i d>
46 <g o a l s>
47 <g o a l>check</ g o a l>
48 </ g o a l s>� �
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (4) �
49 <c o n f i g u r a t i o n>
50 < r u l e s>
51 <!−− i m p l m e n t a t i o n i s needed o n l y f o r Maven 2 −−>
52 < r u l e i m p l e m e n t a t i o n=”org . j a c o c o . maven . R u l e C o n f i g u r a t i o n ”>
53 <e l e me nt>BUNDLE</ e l e me nt>
54 < l i m i t s>
55 <!−− i m p l m e n t a t i o n i s needed o n l y f o r Maven 2 −−>
56 < l i m i t i m p l e m e n t a t i o n=”org . j a c o c o . r e p o r t . check . L i m i t ”>
57 <c o u n t e r>COMPLEXITY</ c o u n t e r>
58 <v a l u e>COVEREDRATIO</ v a l u e>
59 <minimum>0 . 6 0</minimum>
60 </ l i m i t>
61 </ l i m i t s>
62 </ r u l e>
63 </ r u l e s>
64 </ c o n f i g u r a t i o n>
65 </ e x e c u t i o n>
66 </ e x e c u t i o n s>
67 </ p l u g i n>
68 <p l u g i n>
69 <g r o u p I d>org . apache . maven . p l u g i n s</ g r o u p I d>
70 <a r t i f a c t I d>maven−s u r e f i r e −p l u g i n</ a r t i f a c t I d>
71 <v e r s i o n>2 . 1 2 . 2</ v e r s i o n>
72 <c o n f i g u r a t i o n>
73 <s y s t e m P r o p e r t y V a r i a b l e s>
74 <j a c o c o−agent . d e s t f i l e>t a r g e t / j a c o c o . e x e c</ j a c o c o−agent . d e s t f i l e>
75 </ s y s t e m P r o p e r t y V a r i a b l e s>
76 </ c o n f i g u r a t i o n>
77 </ p l u g i n>� �
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (5)

�
78 <p l u g i n>
79 <g r o u p I d>org . apache . maven . p l u g i n s</ g r o u p I d>
80 <a r t i f a c t I d>maven−j a r−p l u g i n</ a r t i f a c t I d>
81 <e x e c u t i o n s>
82 <e x e c u t i o n>
83 < i d>debug−j a r</ i d>
84 <phase>package</ phase>
85 <g o a l> j a r</ g o a l>
86 <c o n f i g u r a t i o n>
87 < c l a s s i f i e r>debug</ c l a s s i f i e r>
88 </ c o n f i g u r a t i o n>
89 </ e x e c u t i o n>
90 </ e x e c u t i o n s>
91 </ p l u g i n>
92 </ p l u g i n s>
93 </ b u i l d>� �
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (6)

�
94 <d e p e n d e n c i e s>
95 <dependency>
96 <g r o u p I d> j u n i t</ g r o u p I d>
97 <a r t i f a c t I d> j u n i t</ a r t i f a c t I d>
98 <v e r s i o n>4 . 1 1</ v e r s i o n>
99 <scope> t e s t</ scope>

100 </ dependency>
101 <dependency>
102 <g r o u p I d>org . j a c o c o</ g r o u p I d>
103 <a r t i f a c t I d>j a c o c o−maven−p l u g i n</ a r t i f a c t I d>
104 <v e r s i o n>0 . 6 . 4 . 2 0 1 3 1 2 1 0 1 1 0 7</ v e r s i o n>
105 <scope> t e s t</ scope>
106 </ dependency>
107 </ d e p e n d e n c i e s>
108 </ p r o j e c t>� �
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (7)

I Criado o novo arquivo de configuração, para gerar o arquivo
jar com as classes instrumentadas para a execução off-line
execute os seguintes comandos, na ordem estabelecida.

1. mvn clean
2. mvn compile
3. mvn test-compile
4. mvn -f pom-jacoco.xml jacoco:instrument
5. mvn package -Dmaven.test.failure.ignore=true

I Ao final deste processo, será gerado um arquivo .jar dentro do
diretório target e nele estão as classes instrumentadas da
aplicação.

I A sequencia de telas a seguir ilustra todo o processo para a
geração do jar instrumentado.
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Instrumentação off-line com Maven e JaCoCo (8)
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (9)
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (10)
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Instrumentação off-line com Maven e JaCoCo (11)
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Instrumentação off-line com Maven e JaCoCo

Instrumentação off-line com Maven e JaCoCo (12)
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Executando a Aplicação Instrumentada

Executando a Aplicação Instrumentada (1)

I Como dentro do código instrumentado existem instruções que
dependem da JaCoCo, para executá-la, é necessário incluir no
CLASSPATH o caminho para o arquivo
org.jacoco.agent-0.6.4.201312101107-runtime.jar,
localizado dentro do repositório local do Maven
.m2/repository/org/jacoco/org.jacoco.agent/0.6.4.

201312101107.
I O comando abaixo ilustra como executar a aplicação

assumindo que o jar com as classes instrumentadas e a o jar
da JaCoCo estejam no mesmo diretório. �

$ j a v a −cp I d e n t i f i e r −1 . 0 . j a r : \
> org . j a c o c o . agent−0 . 6 . 4 . 201312101107− r u n t i m e . j a r \
> I d e n t i f i e r M a i n abcd1
V a l i d o� �
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Executando a Aplicação Instrumentada (2)

I A cada execução do comando anterior, um novo caso de teste
é criado.

I Os dados de execução dos testes ficam armazenados no
arquivo jacoco.exec, que é criado no mesmo diretório onde
o jar da aplicação se encontra.
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Gerando o Relatório de Cobertura (1)

I Para gerar o relatório de cobertura dos testes, basta copiar o
arquivo jacoco.exec para dentro da pasta target do projeto
do Eclipse e, em seguida, executar os Goals:

1. mvn -f pom-jacoco.xml jacoco:restore-instrumented-classes
2. mvn -f pom-jacoco.xml jacoco:report

I Após a execução dos mesmos será criado o diretório
target/site com o relatório de cobertura dos testes
realizados.
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Outras Ferramentas Similares

I EclEmma não é a única ferramenta que apoia a aplicação de
critérios de teste baseados em fluxo de controle.

I Considerando as principais linguagens de programação,
existem outras ferramentas similares, tais como:

I Emma (http://emma.sourceforge.net/) ou EclEmma
(http://www.eclemma.org/) para Java.

I CodeCover (http://codecover.org/) para Java.
I Cobertura (http://cobertura.github.io/cobertura/)
I TCAT (http://www.soft.com/TestWorks) para C/C++ e

Java.
I JavaCov (http://www.alvicom.hu/) para Java.
I Dentre outras...
I Uma lista extensa pode ser encontrada em

http://www.testingfaqs.org/ e
http://www.opensourcetesting.org/.
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Exerćıcio

I Avaliar a cobertura dos casos de teste do programa
CommentPrinter.

I Utilize a ferramenta EclEmma para gerar casos de testes de
modo que 100% dos comandos e decisões de todo código do
programa seja obtido.

I Lembre-se que os casos de testes podem ser feitos no JUnit.

I Entregar os casos de testes desenvolvidos que garantam a
cobertura máxima dos critérios apoiados pela ferramenta.

I Qual a complexidade ciclomática média das classes que
compõem o programa CommentPrinter?
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Referências

I Homepage da EclEmma: pacote, documentação, artigos e trabalhos
relacionados – http://www.eclemma.org/

I Open Source Java Developer Testing Tools – Coletânea de endereços
para várias ferramentas de teste de código livre (não somente para
programas Java) – http://www.opensourcetesting.org/

I Software Testing FAQs – Coletânea de endereços para várias ferramentas
de teste – http://www.testingfaqs.org/

I Open Source Testing Tools in Java –
http://java-source.net/open-source/testing-tools/
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